[image: ]
[bookmark: _Toc174552309][bookmark: _Toc174892080]Title
[bookmark: _Toc174552310][bookmark: _Toc174892081]The Writers’ Mill Journal
[bookmark: _Toc174552311][bookmark: _Toc174892082]Volume 12

[image: ]




Copyrights 2024 by the authors unless otherwise stated.

ISBN: XXXXXXXXX
Imprint: Independently Published

First print version, November 2024
First e-version, November 2024

Cover image by: XXXXXXXX


The Writers’ Mill is a group of writers helping and encouraging writers. The group is based in Portland Oregon but includes members from far afield as well. We run monthly online writing contests and meet every month to attend presentations by guest speakers and critique each other’s writing. We share and celebrate at our meetings every third Sunday of the month, sponsored by the Cedar Mill library of Washington County, Oregon. Since the COVID pandemic we have enjoyed hybrid, online and in-person, meetings in the library at

1080 NW Saltzman Road, Portland, OR 97229

This volume and past editions of The Writers’ Mill Journal are available at

https://www.amazon.com/The-Writers-Mill/e/B081P17P5Q


[bookmark: _Toc142660523][bookmark: _Toc142750038][bookmark: _Toc146287490][bookmark: _Toc173587467][bookmark: _Toc174552312][bookmark: _Toc174892083]TITLE
Blurb


16 ⬥ Title



Contents
Instructions for using this Template	1
How This File Was Set Up	2
How To Insert Submissions	6
How to Order the Entries	7
Pre-Edits	8
Rules for Invisible Edits	10
Some Simple Formatting Rules	12
Some Random Entries for you to play with	1
A Random Poem by Random Author	15
A Centered Poem by Another Author	16
An Essay by Author	17
CONTRIBUTOR BIOS	19



[bookmark: _Toc174892084]Instructions for using this Template
The Writers’ Mill Journal Volume 11 ⬥ 2


[bookmark: _Toc174892085]How This File Was Set Up
This file is created for a 6x9inch paperback book.
First make sure you know how the format works. Then you’ll be able to change things to fit what you want:
· LAYOUT: Click on Layout (top of screen), then on the arrow below “margins”
· Click on “custom margins” at the bottom of the drop-down. This file has custom margins.
· A box will open up. You will see the top, bottom, and side margins are all set to half an inch. You can make this smaller, if you want the text closer to the edges, for example. But you should keep the left and right margins identical.
· The gutter is the extra space added in the middle of the book. It makes it easy to read without breaking the spine of the book. Make sure you have mirror margins set, or the gutter will always appear on the same side of the page, which is not what you want.
· Notice at the bottom of the page, you can make changes to “this section” or to the whole document.
· Click on the layout tab. This is where space is assigned to headers and footers, and also where you state whether your text should start at the top of the page or be centered on the page. This document has some pages with the text centered – see the front page for example.
· STYLES: Now go to the home tab on the top ribbon and find the styles box.
· Right click on a style and choose modify to see what the style looks like. Alternatively, click on the arrow at the bottom right of the styles to open a sidebar with styles in it. You can modify styles from here using the third button at the bottom (the one with the checkmark). You can add new styles using the first button (plus), and you can change which styles appear in the sidebar using options.
· Look at Heading 2. Notice that it’s based on heading 1, and I’ve set the style for the following paragraph to normal.
· You’ll have seen in this file that I’ve set heading 2 up with a background color. You will probably want to change it: Click on format (bottom left) and choose border from the dropdown. You can add a box around the title, choose a shade to color it, or remove all boxes and shading.
· Now look at Normal. Notice the font (Calibri), font size (12), and left and right justification. Calibri has no serifs (little tags on the letters). Books for adults might look better with a different font – say Garamond – where the serifs draw the eye across the page. Books for children need a clear font with good letter shapes – look at the letters a and g and choose a font that makes them the shape you want.
· Click on format at the bottom left of the box and choose paragraph. This is where I’ve set the paragraph indentation to 0.2” (good for a 6x9 page but too small for large pages), line spacing to 1.15 (don’t make it too small, but don’t make it double-spaced either), and zero space at the ends of paragraphs. (You don’t need it if the paragraphs are indented.)
· Other formats are based on Normal. Change the font here and it will change the fonts for poems, separators, quotes and lots of other stuff.
· Try looking at the other styles and see how they are set up. For example, I’ve indented “quotes” using left and right margins, but the paragraphs in quotes are not indented, and they are separated by 6pt spaces. And “info” is a style where the text below the start is indented (kind of opposite of paragraphs).
· SECTIONS: This file is set up with sections. You can see them by clicking on the backwards P in the paragraph box (on the Home tab, there should be clipboard, font, paragraph, and styles boxes). Then scroll to the second TITLE page and notice the line that says “Section break, odd page”. The page numbers start at 1 on the next page.
· You can insert section breaks with Layout>Breaks.
· Choose continuous, starting on next page, starting on odd (great for the start of your book – you want it to start on a left-facing page), starting on even… Just be sure you pick the right one as they can be a pain to change.
· Section breaks are great if you split your book into sections. You can use the section name in the page headers to make it look cool.
· HEADERS AND FOOTERS: These are NOT the same as Headings!
· Double click in the header part of a page, or click on header or footer on the insert tab.
· Look at the headers in this file. Note we have different odd and even page headers, but I didn’t choose “different first page”. I like different first pages for books with serious sections.
· Notice the “link to previous” box. If you create a new section it will default to having the same headers and footers as the previous section. Then if you change the header, you’re changing the previous header too. Remember to unset the link first!
· Notice the page number box. You can add a page number where you want it (ours is top outer edge). You can make it start (in this section) with whatever you want it to start with. You can use Roman numerals for the stuff that comes before the text of the book…
[bookmark: _Toc174892086]How To Insert Submissions
At this point, you might want to print the file, then delete all these “chapters”. Or keep the chapters and add the submissions afterward so you’ve got this stuff for reference, then delete these chapters later.

Insert submissions here:
· Open the file containing the submission
· Cut and paste from that file into this one
· Start by merging styles but then…
· Use Heading two for titles
· Add the author name after the title
· Use Heading three for subtitles
· Maybe capitalize title and don’t capitalize author name
· Use Quote or Quote + italics for author notes
· Use Normal, leftpoem, centerpoem etc for text
##
I’ve included two poems and an essay to give an idea of how it works.
Later you can edit the styles to make it look how you want it to look (though we’ve used these for several anthologies now). As long as you’ve used styles throughout, changing the definition of a style should edit everything to match.
##

[bookmark: _Toc174892087]How to Order the Entries
Use the Navigation Pane to move entries around in the book. Open it in the View tab (a really useful tab for lots of purposes, like making pages fit on the page while you edit them, so you can see the whole page at once). You will find the navigation pane in the “show” section of the tab.
You might want to group some entries together. Add a Heading before them (Some Random Entries in this file). Then you can move all those entries together to another location.
Click on “Some Random Entries” and drag it above “Instructions for using…”
Click on “An Essay” and drag it above “A Random Poem”

When you’ve got all the submissions in your file, try creating some Headings (heading 1), ordering subsets of the submissions under each heading – say, cat stories under a heading Cats; horror stories under Horror, etc.
Look for stories that fit more than one section and place them at the beginning or end of a section so they provide a smooth link between different sections.
Or… scatter cat stories throughout, but keep some link between each story and the one before and after. (You could add comments, using the Review pane, to help you remember what each story is about.)
Or… whatever works for you. It’s easy to move pieces around using the navigation pane. 

[bookmark: _Toc174892088]Pre-Edits
You’ll want to (try to) fix some simple things before sending this out to your editors:
· Remove double spaces (Find space space (ctrl F and type two spaces) and replace with one space). Repeat. This removes the spaces some authors use for paragraph indentation, and the double spaces that some authors use at ends of sentences.
· Remove blank lines at ends of paragraphs
· Find ^p^p and, in most cases, replace with ^p
· If the blank line was meant to be a section break, replace with ## in “separators” style
· Standardize use of emdashes. To do this:
· Replace – (two hyphens) with ^+ (emdash) (but check for longer lines of hyphens too)
· Replace ^= (endash) with ^+ (emdash) except where the endash is between numbers (I would replace space ^+ space with ^+, thus removing unwanted spaces)
· Replace space emdash and emdash space with just the emdash, since US usage doesn’t have spaces around emdashes
· Replace lines of periods with ^I (ellipses).
· This includes lines of periods separated by spaces
· This includes lines of random numbers of periods
· We like to have no space before the ellipsis and one space after – it makes formatting easier
· Tabs ^t are great for lists, but make sure your authors haven’t used them for paragraph indentation. 
· Replace straight quotes with curly ones.
· Replace ^034 with “
· Replace ^039 with ‘
· Then check for wrong-facing curly quotes when they’re used as apostrophes – ‘Tis is wrong, but ’Tis is right. (Type two single quotes and remove the first to get the right effect.)
· Use the same format (see previous chapter, ## in style “separators”) for scene breaks throughout.
· Use italics for internal dialog.
· Replace bold text with CAPITAL or italic text – it looks cleaner on the page.
· Search for (ctrl F) unbreakable spaces (^s) and manual line-breaks (^l)
· Most manual line breaks should be paragraph breaks (^p) so replace them
· Most unbreakable spaces should be regular spaces so replace them.
[bookmark: _Toc174892089]Rules for Invisible Edits
Here are some simple rules for invisible edits.
· If it’s an obvious typo, fix it.
· This might include to instead of too
· Missing (or extra) letters
· Missing (or wrong) quote marks
· Adding commas to overly complicated sentences
· Missing periods or capital letters
· If it’s a not-quite-obvious typo, contact the author.
· If there’s a formatting decision to be made, contact the author
· If it’s unclear, make a suggestion for clarification and contact the author.
· Your suggestion may be as simple as “I want to add commas around this clause”
· Or “Could you name the speaker instead of just saying she?”
· Or “I’d like to make a new paragraph here.”

Remember, the edits are meant to be “invisible”.
· If the author separates paragraphs by topic, you shouldn’t try to separate them by speaker.
· If the author doesn’t use punctuation in a poem, you shouldn’t try to punctuate it.

Remember:
· If possible, your edits and comments will all be made with Word “review>track changes” switched on, so the editor in chief can see what you have changed.
· Try to avoid “modern comments” as they really mess up your ability to attach comments to changes.
· In Word: Use File>options>general and make sure there is no checkmark next to “modern comments”
· The editor in chief will combine everyone’s edits and comments, then contact the author as appropriate.
· Not all your suggestions will make it into the final document, but all your suggestions will be appreciated!
[bookmark: _Toc174892090]Some Simple Formatting Rules
Word can do a lot, but sometimes you need to coax it.
Start by making sure widows and orphans control is on. As long as you used the styles in this document, they should be on. But styles imported from other documents may have them switched off. Best is to change those to “normal” but just for reference, in case your “normal” gets broken:
· Select some text that is in “normal”
· Modify the style (either by right clicking “normal” in the styles window, or by opening the styles list (the small arrow at the bottom right of styles – normal should already be selected) and clicking on the bottom right A (the one with the checkmark) to “modify style”
· Click “modify”
· Click “format>paragraph”
· Click “advanced”
· Click “widow and orphan control” under “line and page breaks”

Then there are the clever tricks to clean up white-space:
· If an entry only just goes over a page, try to pull it back by selecting a few paragraphs, then
· Under Font, click the small arrow at the bottom right
· Click on the “advanced” tab
· Instead of normal, choose condensed, say, by 0.1 (or 0.2)
· Alternatively, you might make a few more lines go over the page by doing the same but
· This time choose expanded by, say, 0.1…
· If a paragraph ends with a single word – especially if it ends with a single word at the end of a page! – try
· Looking for a crowded line in the paragraph and using a manual line break to move words to the next line, till it ends with more than one word
· Or using font>advanced>expanded as above.

To create something really sophisticated, you can make all first paragraphs start with no indentation (use the arrow under paragraph) and even add drop caps (click inside that first paragraph and insert drop-caps) BUT drop caps is super-ugly when the first character is a quotation mark, so remove the quotation mark first.
· You can insert the quotation mark again in a small text box, provided the “anchor” for the text box is inside the “box” for the dropped cap.

Pictures are a pain and will frequently move around as you format your doc. Make sure you know where the anchors are, as that will help. And remember you can “fix” them by right clicking and editing the size and position. Also, remember to use “picture format” to decide how you want the text to wrap, and where you want the image on the page.

I centered the headings (Instructions and Some Random Entries) by selecting the text, then going to Layout>Page setup. Click the arrow at the bottom right and go to the Layout tab. Choose “centered” in the middle of the box, and remember to choose “selected text” at the bottom where it asks where to apply the change.
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[bookmark: _Toc174892092]A Random Poem by Random Author
This is a poem
That starts at the edge
Of the page, every line
Set the same.

This is a poem
With spaces between
Each stanza. It seems
Pretty boring.

Sorry about that.

[bookmark: _Toc174892093]A Centered Poem by Another Author
I’ve centered these lines
To look cool on the page
Not sure of the words
But it’s surely a shape
That you’ll love
[bookmark: _Toc174892094]An Essay by Author
Submitted to a Writers Mill contest
I’m writing an essay and trying my best to make a few errors for future editors to find.  Though it’s kind of hard sometimes. Word fixes so many things, like emdashes and endashes – just does what it should when I type  what I should—like this I suppose---but not like that.
There’s ellipses too . . . and they can cause trouble when they land . . . in the wrong place on the line. So I guess my editor would have to fix them...
And then there’s choosing my own indentation for lines. Perhaps I’ll use tabs.
	Yes, I’m sure this looks good. Though I could count spaces instead.
       Somewhere around seven. Yes. Great!
Hope this helps.
Good luck
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Contributor name has been a member of the Writers’ Mill for many years. She writes childrens stories, poetry, novels, essays, science articles, and self-help books. Find her work on her website at www.contributorxxxxx.com 
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Fill in the editor names here
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